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The first few articles in the FPGA series covered different Nios® Il projects on the MAX 10. Nios Il
has been around for a long time. With the release of RISC V, Intel developed the Nios V 32-bit soft
processor core based on RISC V ISA (RISC V 32I) to replace Nios Il moving forward. Nios V was
firstintroduced to the higher-end of the Intel FPGA family. Now that Nios V has been made available
in the Quartus Prime Standard and Lite editions, Nios V projects can be built on the Max 10,
Cyclone V, Cyclone 10LP, and Cyclone IV. This hands-on article will walk through the creation of
a basic Nios V design, and we will explore some tool features along the way.

Please, see the article Altera™ Quartus® Prime Lite v25.1 and Nios® V Install Instructions on
Annabooks.com for information on how to install the Quartus software needed for this hands-on
exercise.

The Project Requirements:

¢ Quartus Prime Lite Edition V25.1, Ashling RiscFree™ IDE, and Nios® V licenese are
already installed.

o Intel® MAX® 10 - 10M08 Evaluation Kit and the schematic for the evaluation board are
required. The schematic PDF file can be downloaded from the Intel FPGA website.

e FPGA Programming cable — USB Blaster Il or EthernetBlaster Il. The Intel® MAX® 10 -
10MO08 Evaluation Kit doesn’t have a built-in USB Blaster Il onboard.

Note: There are equivalent MAX 10 development and evaluation boards available. These boards
can also be used as the target, but you will have to adjust for the available features on the board.
Please, make sure that you have the board’s schematic files as these will be needed to identify
pins.

Note: As of this writing, Altera is still migrating information and licensing details from Intel. You will
see a mix of both company names until the transfer is complete.

The Nios V workflow is different than the Nios Il projects.

o The first step is still the same: creating the hardware design in Quartus Prime and Platform
Builder.

e The second step is to use the Nios V command line to create the BSP and the cmake
project.

e The final step is to write and debug the application with RiscFree IDE.

1.1 Part 1: Basic Nios V Design

For the FPGA design, we will have a Nios V/m processor IP block, along with an onboard RAM IP
Block, and a JTAG UART IP Block. The application will simply send messages out the JTAG
interface to a console application.
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1.1.1 Create the Project
The first step is to create a design project.

1. Open Quartus.
2. Click on the New Project Wizard.

- Home [E

d Quartus® Prime Development Suite

Recent Projects

£ E-/FPGAINtel Max_10_FPGA Evaluation KiuNIOSV Example/NIOSVCPU gpt

New Project Wizard... f
. E:/FPGA/Intel_Max_10M50_Evaluation_Kit/niosv_uart/niosvuart.qpf

£, Open Project. ﬁ E-/FPGAVINtel_Max_10MS0_Evaluation_Kit/nios_pio/nios_int_pio gpf
H | E E-/FPGAVIntel_Max_10M50_Evaluation_Kit/niosv_gpio/niosvapio gpf
elp % E:/FPGA/ATOWMAXTO00/MAXNIOSV/MAXLO_NIOSV.qpf

g E-/FPGA/ArrowMAX1000/NIOSV_HelloWorld/NIOSV_PIO gpf
T E-/FPGA/niosv-example-projects-main/niosv-example-projects-main/2 niosv_soc_sd
g E:/FPGA/niosv-example-projects-main/niosv-example-projects-main/1.niosv_soc_ex

|BE] Quartus Prime Docurnentation

[ ! Training

5

4?% Quartus Prime Software Support
) What's New

Additional Design Tools

Q)7 FPGA Al Suite
E DSP Builder
Featured Design & Support Resources

s & @ T M

3. Select or create a project directory \NIOSV_Example (Do not use the Quartus
installation directory) and name the project: “NIOSVCPU?”. Click Next.

Note: By default, the root directory is the Quartus installation directory. Make sure the root project
directory is a separate path from the Quartus installation files. Also, there can be no spaces in the
name of the folders or projects.

4. Project Type: Empty project, click Next.

5. Add File: no files to add, click Next.

6. Family, Device & Board Settings: click the Board tab and select: MAX 10 FPGA 10M08
Evaluation Kit. Click Next.
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& New Project Wizard

Family, Device & Board Settings
Device Board
Select the board/development kit you want to target for compilation.

Family: | MAX 10 * | Development Kit: | Any

Awailable boards

V| Create top-level design file.

Can't find your board? Check the Design Store for additions and search for baseline under Design Examples

Help < Back Next > Einish

Name Version Family Device Vendor
B Arrow MAX 10 DECA 0.9 MAX 10 TOMS0DAF484C6GES  Arrow
BH  BeMicro MAX 10 FPGA Evaluation Kit 1.0 MAX 10 T0OMOBDAF4B4CBGES  Arrow
FH MAX 10 DE10 - Lite MAX 10 10MS0DAF484C6GES Altera

B max1orpca Development Kit MAX 10 10MS0DAF256CTG  Altera
FH  max 10 NEEK 1.0 MAX 10 T0MSODAF484I7G Terasic
= Odyssey MAX 10 FPGA Kit 1.0 MAX 10 10MO8SAUT69C8GES Macnica ...

497¢

806«

497¢

a MAX 10 FPGA 10M08 Evaluation Kit - MAX 10 10MOBSAE144C8GES E

407¢

407¢

806«

Cancel

7. EDA Tools: click Next.
8. Summary: click Finish

1.1.2 Create the Design Step 1: Platform Designer

Quartus supports many design types to create an FPGA design. The Platform Designer tool will be
used for this hands-on exercise. Platform Builder makes it easy to add already-built IP blocks and

interconnect them.

1. From the menu, select Tools->Platform Designer, or the Platform Designer icon

from the toolbar. The Platform Designer tool is launched. By default, a clock (clk_0) is
added to the design. Platform Designer makes it easy to add IP blocks and make

interconnections between the blocks.

2. The top left pane contains the IP Catalog with all the available IP blocks that come with

Quartus Prime. In the search box, type nios.
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® NIOSV

Library
é--Basic Functions
[=-Simulation; Debug and Verification
[E)-Simulation

‘. ® Nios IT Custom Instruction Master BFM Intel FPGA IP
“- ® Nios II Custom Instruction Slave BFM Intel FPGA IP
[J-Processors and Peripherals

é--Co-Processcrs

[)-Mios IT Custom Instructions

L. ® Bitswap

Custom Instruction Interconnect
Custom Instruction Master Translator
Custom Instruction Slave Translator
Floating Point Hardware

L]
L]
L]
L]

[ # Floating Point Hardware 2
[=-Embedded Processors
i ® Nios Vfc Compact Microcontroller IP

# MNios Vg General Purpose Processor IP
S W ios Vjm Microcontroller IP

3. Expand the Processors and Peripherals and the Embedded Processors branches. Under
Embedded Processors double-click on the Nios V/m Processor Intel FPGA IP.
4. This will open the Nios V/m Configuration page. We will keep the defaults for now. Click

Finish.

_:i‘l:ﬂ

\System: NIOSY  Path: intel_niosv_m_0
Nios V/m Microcontroller Intel FPGA IP
intel_niosv_m

= Designs

Far available Nios V/m Example Designs, please visit the Intel Design Stare

Link - https: fwmw.intel.com/content/www/usfen/suppor t/programmable fsuppor t resources,design-examples,design-store.html

|~ Debug

(8 Enable Debug
() Enable Reset from Debug Module

|~ Use Reset Request

(] Add Reset Request Interface

[+ Vectors

Reset Agent: | absolute >
Reset Offset: |gynooonoog

[~ cru

When pipelining is enabled, IPC is higher at the cost of more area and lower frequency.

(8 Enable Pipelining in CPU

[* Ecc

() Enable Error Detection & Status Reparting

5. Now let’'s add the RAM IP block. In the IP Catalog enter RAM in the search box.

6. Double-click on On-chip Memory (RAM or ROM) in the Intel FPGA IP.

Copyright © 2025 Annabooks, LLC. All rights reserved
Intel is a registered trademarks of Intel Corporation
Quartus, Nios I, Nios V, and MAX 10 are registered trademarks of Altera

All other copyrighted, registered, and trademarked material remains the property of the respective owners.



Annabsoks®

Rev 0

M Ip Catalog 32 ==
L RAM X e
P_roiect
Ll New Component...
Library

E=I-Basic Functions
[=-0n Chip Memory

[ W r-Chip Memory (RAM or ROM) Intel FPGA IP
=-DSP

=-Video and Image Processing

fe ® Frame Buffer I (4 Ready) Intel FPGA IP
=-Memary Interfaces and Controllers

é--Memory Interfaces with AltMemPHY

b @
Ié\‘--Memory Interfaces with UniPHY

----- #® DDRZ SDRAM Controller with UniPHY Intel FPGA IP
! DOR.3 SDRAM Controller with UniPHY Intel FPGA IP
LPDDR 2 SDRAM Contraller with UniPHY Intel FPGA IF

(=l-University Program
[=HClock
<

New... Edit...

o add...

7. The configuration page will appear. Change the Total memory size to 32000. More memory
is require to run Nios V applications.

|"’ Size

Total memaory size:

Enable different width for Dual-port access
Slave 51 Data width:

St

bytes

Minimize memaory block usage (may impact fmax)

Intel Max 10 Part Logic Elements Maximum Maximum User I/O
Number Embedded Memory Count
10M02 2000 108 Kbits 246
10M04 4000 189 Kbits 246
10M08 8000 378 Kbits 250
10M16 16000 549 Kbits 320
10M25 25000 675 Kbits 360
10M40 40000 1.26 Mbits 500
10M50 50000 1.638 Mbits 500

8. Uncheck the box for “Initialize memory content”, and click Finish.
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[* Memory initialization

[] initizlize memory content

Enable non-default initialization file

User created initizlization file: onchip_mem.hex

Enable Partial Reconfiguration Initialization Mode

9. Inthe IP Catalog search, enter uart.

10. Double-click on the JTAG UART Intel FPGA IP.

Type the filename {g.g: my_ram.hex) or select the hex file using the file browser button.

M IpCatalog

- =

4, uart

X| K2

Project
Ll New Component...
Library

=)-Interface Protocols

. [=-Serial

Iél--Uni'u'ersity Program
E--Cnmmunications

----- & IrDA UART

----- ® R5232UART

----- # 15550 Compatible UART Intel FPGA IP
----- LI TTAG UART Intel FPGA IP
----- #® UART (R5-232 Serial Port) Intel FPGA IP

Mew... Edit...

& Add...

11. A configuration page will appear. There are no changes to be made. Click Finish.
12. In the IP Catalog search, enter the system ID.

13. Double-click on the System ID Peripheral Intel FPGA IP.
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8 IpCatalog 2 S el |
-, sys ¥ KX
P_ruject

Ll New Component...

Li_brar\r

[=-Basic Functions
E}--Simulaﬁun; Debug and Verification
EI--DEbug and Performance
i @ Intel FPGA In-System Sources & Probes
- ® 5LD Hub Contraller System
System ID Peripheral Intel FPGA IP

‘. ® Trace System

[=-Processors and Peripherals

[=h-Hard Processor Systems
e

I';'l--Uljiversity Program
=Clock
‘. ® System and SDRAM Clodks for DE-series Boards

14. A configuration page will appear. There are no changes to be made. Click Finish.

!_, System Contents 2% | AddressMap i3 | Interconnect Requirements &3

- ! System: unsaved

Use

H4» M Bl Xm@+

Connections

Name Description Export
B dk_0 Clock Source
dk_in Clock Input clk
dk_in_reset Reset Input reset
dk Clodk Output
dk_reset Reset Output
B 1] intel_niosv_m_0  |Nios V/m Processor Intel FPGA IP
dk Clock Input
reset Reset Input
platform_irg_rx Interrupt Receiver
instruction_manager AXI4 Master
data_manager AX14 Master
timer_sw_agent Avalon Memory Mapped Slave
dm_agent Avalon Memory Mapped Slave
B onchip_memory2_0 |On-Chip Memary (RAM or ROM) Intel ...
dk1 Clock Input
51 Avalon Memory Mapped Slave
resetl Reset Input
E jtag_uvart_0 JTAG UART Intel FPGA IP
dk Clock Input
reset Reset Input
avalon_jtag_slave Avalon Memory Mapped Slave
irq Interrupt Sender
= sysid_gsys_0 System ID Peripheral Intel FPGA IP
dk Clock Input
reset Reset Input
control_slave Avalon Memory Mapped Slave

Copyright © 2025 Annabooks, LLC. All rights reserved
Intel is a registered trademarks of Intel Corporation
Quartus, Nios I, Nios V, and MAX 10 are registered trademarks of Altera

All other copyrighted, registered, and trademarked material remains the property of the respective owners.

Clock

dk_0

unconnectea
[clk]
[clk]
[clk]
[clk]
[ak]
[dk]

unconnectea
[clk1]
[clk1]

wnconnectea

[clk]
[clk]
[clk]

unconnectea
[clk]

[clk]

Base

0x0001
Ox0000
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15. Now, we need to wire the IP blocks together. First, wire all the clk lines together by clicking
on the dots for all four IP blocks.

_ Address Map  ¥% | Interconnect Requirements &3

- ! System: unsaved Path: sysid_gsys_0.dk

+.
=
+ Use
% =
X
=
“ o
b
¥
a
a
a

Connections

Mame

B ck_0
dk_in
dk_in_reset
dk
dk_reset

B I intel_niosv_m_0
dk
reset
platform_irg_rx
instruction_manager
data_manager
timer_sw_agent
dm_agent

E onchip_memory2_0
k1
s1
resetl

B jtag_uvart_0
fal'3
reset
avalon_jtag_slave
irq

B sysid_gsys_0

reset
control_slave

Description
Clock Source
Clock Input
Reset Input
Clock Qutput
Reset Output
Mios V/m Processor Intel FRGA IP
Clock Input
Reset Input
Interrupt Receiver
AXI4 Master
AXI4 Master
Avalon Memory Mapped Slave
Avalon Memory Mapped Slave

On-Chip Memory (RAM or ROM) Intel ...

Clack Input

Avalon Memory Mapped Slave
Reset Input

JTAG UART Intel FPGA IP

Clock Input

Reset Input

Awalon Memory Mapped Slave
Interrupt Sender

System ID Peripheral Intel FPGA IP

Clodk Input
Reset Input

Avalon Memory Mapped Slave

Export

clk

Double-dlick to export

clk_0
[dk]
[dk]
[clk]
[dk]
[dk]
[dk]

clk_0
[dk1]
[dk1]

clk_o
[clk]
[dk]
[clk]

[clk]

[clk]

Base

0x0010
0001

16. Next, connect all the reset lines together by clicking on the dots for all four IP blocks.
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_ Address Map &% | Interconnect Requirements  ©3

a u System: unsaved Path: sysid_gsys_0.reset

Use

M 4r M & ¥&+

Connections

Mame

B clk_0
dk_in
dk_in_reset
dk
dk_reset

B I intel_niosv_m_0
dk
reset
platform_irg_rx
instruction_manager
data_manager
timer _sw_agent
dm_agent

B onchip_memory2_0
dk1
s1
resetl

A jtag_uvart_0
dk
reset
avalon_jtag_slave
irg

B sysid_gsys 0
dk

control_slave

Description

Clock Source

Clock Input

Reset Input

Clock Output

Reset Output

Mios ¥/m Processor Intel FPGA IP
Clock Input

Reset Input

Interrupt Receiver

AXI4 Master

AXI4 Master

Avalon Memory Mapped Slave
Avalon Memory Mapped Slave
On-Chip Memory (RAM or ROM) Intel ...
Clock Input

Avalon Memory Mapped Slave
Reset Input

JTAG UART Intel FPGA IP

Clock Input

Reset Input

Avalon Memory Mapped Slave
Interrupt Sender

System ID Peripheral Intel FPGA IP

Clock Input
Reset Input
MAvalon Memory Mapped Slave

Export

clk

Double-click to export

Base

Ox
Ox

17. The memory lines have to be connected together. Connected the Introduction_manager

and data_manager to all other items in the design.
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AddressMap &% | Interconnect Requirements &8

X a “ System: unsaved Path: sysid_gsys_0.control_slave
+ Use Connections MName Description Export Clock Base
! -] B ck_0 Clock Source
X == dk_in Clock Input clk exported
E o dk_in_reset Reset Input reset
: —<¢ dk Clock Output clk_0
= — dk_reset Reset Output
- ] B i intel_niosv_m_0  |Nios V/m Processor Intel FPGA IP
v dk Clock Input clk_0
h 4 reset Reset Input [clk]
platfarm_irq_rx Interrupt Receiver [clk]
] instruction_manager AX14 Master [clk]
g, data_manager AX14 Master [clk]
p— timer_sw_agent Awalon Memory Mapped Slave [clk] 0x00C
dm_agent Avalon Memory Mapped Slave [clk] 0x00C
(] E onchip_memory2_0 |On-Chip Memory (RAM or ROM) Intel ...
dk1 Clack Input clk_0
sl MAvalon Memory Mapped Slave [clk1] 0x00C
resetl Reset Input [clk1]
(] B jtag_uart_0 ITAG UART Intel FPGA IP
k Clack Input clk_0
reset Reset Input [clk]
avalon_jtag_slave Avalon Memory Mapped Slave [clk] 0x00C
irg Interrupt Sender [clk]
-] B sysid_gsys_0 System ID Peripheral Intel FPGA IP
dk Clock Input clk_0
reset Reset Input [clk]
control_slave Avalon Memory Mapped Slave Double-dlick to export |[dk]

18. Finally, connect the jtaq_uart irq line to the intel_niosv_m_0.
19. If you scroll to the right, the irq is given a default value.

_ Address Map 33‘ Interconnect Requirements 33‘

a5

E & - System: unsaved Path: jtag_uart_0.irg
+ Use  Connections Name Description Export Clock Base End IRQ T
| [ ] 0 dk_o Clock Source
* (=2 dk_in Clock Input clk exported
= =8 dk_in_reset Reset Input reset
. —— dk Clock Output clk_0
= — ck_reset Reset Output
- [ ] = EQ intel_niosv_m_0  Nios V/m Processor Intel FPGA IP
hd ck Clock Input iclk_o
h 4 reset Reset Input [clk]
platform_irg_rx Interrupt Receiver [clk] I=Q 0 IRQ 15—
— instruction_manager  |AXI4 Master [ch]
— data_manager AXI4 Master [clk]
—: timer_sw_agent Avalon Memory Mapped Slave [clk] 0x0001_0000 0x0001_003£
dm_agent Avalon Memory Mapped Slave [clk] 0x0000_0000 0x0000_££££
a E onchip_memory2_0 |On-Chip Memory (RAM or ROM) Intel ...
dkl Clock Input clk_0
s1 Avalon Memory Mapped Slave [clk1] 0x0000_0000 0x0000_TEEE
resetl Reset Input [clk1]
[ -] B jtag_uvart 0 JTAG UART Intel FPGA IP
dk Clock Input iclk_0
reset Reset Input [clk]
avalon_jtag_slave Avalon Memory Mapped Slave [clk] 0x0000_0000 0:x0000_0007
Interrupt Sender Double-click to export
[ -] [ sysid_gsys_0 System ID Peripheral Intel FPGA IP
dk Clock Input clk_0
reset Reset Input [clk]
control_slave Avalon Memory Mapped Slave [clk] 0x0000_0000 0x0000_0007
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20. Let’s assign a base address. From the menu, select System->Assign Base Address. This
will remove a number of errors from the message box.

Platform Designer - unsaved.gsys™ (EAFPGAN ntel_Max_10_FPGA_Evaluatis

File Edit Systemn Generate View Tools Help

:="IPIC5 Upgrade IP Cores... "f: !S'y
{ Assign Base Addresses a
~u SY5| )
! Assign Interrupt Numbers
Projec L
Lol Assign Custom Instruction Opcodes
Library Create Global Reset Metwork
EH Show Systern With Platform Designer Interconnect

Remove Dangling Connections

Import Interface Requirements...
=W ITdLE SySIE T

M 4> M Bl X i@+

21. Finally, let's set the reset and exception vector addresses. Double-click on the
intel_niosv_m_0 to open the configuration page.
22. In the Vectors section, change the Reset Agent to onchip_memory2_0.s1

System: NIOSY  Path: intel_niosv_m_0

Nios V/m Microcontroller Intel FPGA IP

intel_niosv_m

[* Example Designs

For available Mios V/m Example Desians, please visit the Intel Design Store

Link - https: /fwww.intel. comcontent fiwww fus fen/support/programmable fsupport-resc

[~ Debug
8 Enable Debug

[ Enable Reset from Debug Module

[~ Use Reset Request
(] Add Reset Request Interface

[~ vectors
Reset Agent: | grchip_memory2_0.51 v
Reset Offset: |oxo0000000

| T R ——

23. Click on Generate HDL...

24. A gialog appears, keep the defaults and click the Generate button.

25. A dialog will appear asking you to save the design, click Save.

26. Give the name as NIOSV.gsys and click Save.

27. Once the save has been completed, click Close.

28. The generate process kicks off. The processes should succeed with warnings, click Close.
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ss Generate Completec >,

G < S - @

| @ Info: Reusing file E:/FPGA/Intel_Max_10_FPGA_Fvaluation_Kit/NIOSV_Example/NIO:

' | @ Info: NIOSV: Done "NIOSV™ with 33 modules, 58 files

@ Info: rsp_ demux 004 "mm_interconnect_0" instantiated altera_merlin dEI‘IlIJltIplE‘)
@ Info: rsp_mune “mm_interconnect_0" instantiated altera_merlin_multiplexer “rsp_m

@ Info: rep_mux_002: "mm_interconnect_0" instantiated altera_merlin_multiplexer “r
@ Info: Reusing file E:/FPGA/Intel_Max_10_FPGA_Evaluation_Kit/NIOSV_Example/NIO:
@ Info: avalon_st_adapter: "'mm_interconnect_0" instantiated altera_avalon_st_adap
@ Info: error_adapter_O: "avalon_st_adapter” instantiated error_adapter "error_adap

@ Info: gsys-generate succeeded. |
@ Info: Finished: Create HDL design files for synthesis

20.
30.
31.
32.

33.

34.

1, Generate: completed with warnings.

Click Finish to close the design.

Quartus then reminds you to add the new design to the project. Click Ok.
In the Project Navigator, click on the drop-down and select Files.
Right-Click on Files and select Add/Remove Files in Project.

Project Navigator @ Files * QIRIE &

i Add/Remove Files in Project...

A Settings — NIOSVCPU page appears with Files on the left highlighted. Click the three
dots, browse button for File name, and navigate to \NIOSV_Example\NIOSV\synthesis
folder.

Click on NIOSV.qgip file and click open

Mame
submodules
[ NIOSV.gip

[ NIOSV.

35. Click OK to close the Settings - NIOSVCPU page. The qip file is added to the Project

navigator list. Underneath are all the Verilog files that were generated by Platform Builder.
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Project Navigator =| Files v O R@E

Files
- E MIOSY {synthesis/MNIOSVY. gip
MIOSV/synthesis/NIOSW.v
MIOSV/synthesis/submaodules/altera_reset_controllery
MNIOSV/synthesis/submodules/altera_reset_synchronizer.v
NIOSV/synthesis/submodules/altera_reset_controller.sdc
MNICSV/synthesis/submeodules/NIDSV_irg_mapper.sv
NIOSV/synthesis/submeodules/NIOSY_mm_interconnect_0.v
MIOSVsynthesis/submodules/MIOSY_mm_interconnect_0_avalon_st
MIOSVsynthesis/submodules/MNIOSY_mm_interconnect_0_avalon_st
MIOSVsynthesis/submodules/NIOSY_mm_interconnect_ O rsp_rmux_
MIOSV/synthesis/submodules/altera_merlin_arbitrator.sv
MNIOSV/synthesis/submodules/NIOSY_mm_interconnect_0_rsp_mux.s
NIOSV/synthesis/submodules/NIOSY_mm_interconnect_0_rsp_demu
NIOSV/synthesis/submodules/NIOSY_mm_interconnect 0 _rsp_demu

L]
E=E:E:E:E:E:E=E:E=EU = T
o

RV fmn smt i imm i e e s il FRIFAE VS mmmm it mrmmmmmed M ommmed e ~

36. Save the project.

37. In the project navigator, right click on NIOSV.qip and select “Set as Top-Level Entity”.

38. In the Task pane on the left, double-click on Fitter (Place & Route) to start the task. The
analysis will take some time, and it should succeed in the end. This step helps to diagnose
any errors and finds the Node Names for the pin assignments in the next step.

39. Once the process completes, the pin assignments need to be set. From the menu select

Assignments->Pin Planner or click on the = icon from the toolbar. The analysis that
was just run populated the Node Name list at the bottom of the Pin Planner dialog.

® | Named: * v | ¥ |Edit
i} Mode Name Direction Location 1/ Bank WREF Group Fitter Location I/ Standard Re:
iﬁ_ altera_reserved tck Input PIN_18 2.5V (default)
i altera_reserved_tdi Input PIN_19 2.5 V (default)
‘@ altera_reserved_tdo Output PIN_20 2.5V (default)
iﬁ_ altera_reserved_tms  Input PIN_16 2.5V (default)
iﬁ_ clk_SOMHz Input PIN_28 2.5V (default)
B swi1 Input PIN_29 2.5V (defaul)

<=new nodez>

il Pins

40. Using the board schematic, locate the pins for the SW1 and the 50Mhz clock. Set the
Location values for both node names. For the MAX 10 — 10M08 Evaluation Board, these
values are as follows:
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Node Name Location
SW1 PIN 121
Clk 50MHz: PIN 27
altera_reserved tck PIN 18
altera_reserved tdi PIN 19
altera_reserved tdo PIN 20
altera_reserved tms PIN 16

41. Set the I/O Standard to 3.3V-LVTTL for both pins. You can see from the schematic that all

of the 1/O are tied to 3.3V.

® | Named:| * v |« | Edit

=

i} MNode Name Direction Location 1O Bank VREF Group Fitter Location
iy altera_reserved_tck Input PIN_18 1B B1_NO PIN_18
- altera_reserved tdi Input PIN_19 1B B1_NO PIN_19
.°"'.t altera_reserved_tdo Output PIN_20 1B B1_NO PIN_20
@ altera_reserved tms  Input PIN_16 1B B1_NO PIN_16
B clk_50MHz Input PIN_27 P B2_NO PIN_28
B SW1 Input PIN_121 8 B2_NO PIN_29

n | <<new nodes>

c

=

42. Close the Pin Planner when finished.
43. Save the project.

1.1.3 Add Design Constraints File

IfO Standard Resel
2.5V (default)
2.5V (default)
2.5V (default)
2.5V (default)
3.3-V LVTTL
3.3-V LVTTL

From the menu in Quartus, select File->New-> Synopsys Design Constraings File

1.
2. Click Ok
3. Add the following:

#50MHz clock 1/50 = 0.02 or 20ns
#1/50000000 = 20e-9 20ns
#create_clock -period "50Mhz" -name clk_50MHz clk_clk

create_clock -period 20.000 -name clk_50MHz clk_clk
derive_clock_uncertainty
set_false_path -from [get_ports reset_reset_n]
set_false_path -from [get_ports altera_reserved*]
set_false_path -from * -to [get_ports altera_reserved_tdo]
4. Save the file as NIOSVCPU.sdc
1.1.4 For MAX 10, set configuration scheme

Set the configuration for the device.

1. From the Quartus menu, select Assignments->Device
2. Click on the “Device and Pin Options...” button.
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3. Set the internal configuration mode to “Single uncompressed image with Memory
initialization (256Kbits UFM)”

Category:

General
Configuration
Programming Files
Unused Pins

Specify the device configuration scheme and the configuration device.

Dual-Purpose Pins Configuration scheme: | Internal Cenfiguration -
Capacitive Loading

Board Trace Model Configuration mode: Single Uncompressed Image with Memory Initialization (256K bits UFM) =
I/C Timing ) ) )

Voltage Configuration device

Pin Placement

4. Click OK
5. Click OK

1.1.5 Compile the Project

Note: A best practice at this point would be to make a backup of the project folder. Quartus can
crash unexpectedly.

1. Finally, compile the design. In the Task pane, right-click on Compile and Design and select

Start from the context menu, or you can click on the symbol in the toolbar. The

compile should complete successfully.

&, <<Filters>

Flow Status

Quartus Prime Version
Revision Mame
Top-level Entity Name
Family

Device

Timing Models

Total logic elements
Total registers

Total pins

Total virtual pins

Total memory bits
Embedded Multiplier 9-bit elements
Total PLLs

UFM blocks

ADC blocks

Successful - Mon Aug 18 13:23:34 2025
24.1std.0 Build 1077 03/04/2025 SC Lite Edition
MNIOSVCPU

NIOSV

MAX 10

T0MOBSAET144CBGES

Preliminary

5,423 [ B,064 (67 %)

2509

2/101(2%)

0

260,736/ 387,072 (67 %)
0/48(0%)

0/1(0%])

0/1(0%)

0/1(0%)

1.2 Part 2: Nios V Shell Create BSP and Cmake Application

For Nios I, the next step would be to open Eclipes and create the software project with the .sopcinfo
file, which also creates the BSP. The Nios V application development process is not as integrated
as the more mature Nios Il. There are a few more manual steps before we get to the IDE
environment. The good news is that Nios V and RiscFree IDE do not require WSL if you are running
on Windows. Only Cmake is required. This section will create the BSP and basic application project,
and the following section will be used to create the application in RiscFree IDE.

1. From the Start menu, open the Nios V Command Shell.
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2. A command window appears. Change directory to C:\altera_lite\25.1std\niosv\bin> if the
window doesn’t open to the folder.
3. Enter DIR and hit enter. You will see a number of applications available.

r
Nios V Command Shell (Quart + |~

[niosv-shell] C:\Users\SEAN_\AppData\Local\quartus> cd \altera_lite\25.1std\niosv\bin

[niosv-shell] C:\altera_lite\25.1lstd\niosv\bin> dir
Volume in drive C is 0S
Volume Serial Number is 8U©7-T76ED

Directory of C:\altera_lite\25.1std\niosv\bin

12/15/2825 : PM <DIR>
12/15/2825 A PM <DIR= na
10/22/20825 :16 PM 2U8,832 elf2flash.exe
10/22/2025 ] PM 91,867 elf2flash.jar
10/22/2025 : PM 248,832 elfZhex.exe
10/22/20825 : PM 71,571 elf2hex.jar
10/22/2825 :25 PM 293Ul niosv-app.exe
10/22/20825 :25 PM 249,344 niosv-bsp-editor.exe
10/22/20825 :24 PM 209,344 niosv-bsp.exe
12/15/2825 108 PM <DIR> niosv-download—files
10/22/20825 :29 PM 218,112 niosv-download.exe
12/15/2825 108 PM <DIR> niosv-shell-files
18/22/2825 :29 PM 218,112 niosv-shell.exe
12/15/2825 :08 PM <DIR> niosv-stack-report—files
1e/22/2825 :29 PM 218,112 niosv-stack-report.exe
10 File(s) 2,063,470 bytes
5 Dir(s) 1,392,203,388,U16 bytes free

[niosv-shell] C:\altera_lite\25.1std\niosv\bin>

Run niosv-bsp-editor.exe

The BSP Editor opens up.

From the menu, select File-New BSP...

Click on the button with 3 dots for “SOPC Information File name:”

Open the NIOSVCPU.sopcinfo. As the file opens, the file information is read and fills the
rest of the dialog.

i S

Hardware
SOPC Information File name:  |E:\FPGA\Intel_Max_10_FPGA_Evaluation_Kit\NIOSV_Example\MIOSV. sopcinfa

CPUname: |intel_niosv_m_0 v
Software
Operating system: | Altera HAL - Version: |default -
Use default locations
BSP target directory:  |:\FPGANIntel_Max_10_FPGA_Evaluation_Kit\NIOSV_Example'softwarethal_bsp
BSP Settings File name: | _Max_10_FPGA_Evaluation_Kit\NIOSV_Example'\softwarehal_bsp'settings.bsp

Enable Settings File relative paths

[T Enable Additional Td script

OK ] Cancel
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9. Uncheck the Use default locations and change the BSP target directory from hal_bsp to
bsp.The BSP will be created in a software\bsp subfolder under the \NIOSV_EXAMPLE

project.

i Mew BSP
Hardware
SOPC Information File name: | E:'FPGA\Intel_Max_10_FPGA_Evaluation_Kit\NIOSY_ExampleWWIOSV, sopdnfo

CPU name: |intel_niosv_m_0 v
Software
Operating system: | Altera HAL v Version: | default v
[ Use default locations
BSP target directory:  |E:'FPGANINtel_Max_10_FPGA_Evaluation_Kit\NIOSY_Example\software \bsp
BSF Settings File name: | ntel_Max_10_FPGA_Evaluation_Kit\NIOSY_Example'software'bspsettings.bsp
B Enzble Settings File relative paths

[ Enable Additional Tdl script

Additional Td script:

Carcel

10. Just like Nios Il, the BSP editor provides all the configurable items available in the BSP.
Click OK.
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11. Under Settings root, uncheck “enable_c_plus_plus”
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= B itor - EAFPGANNtel_Max_10_FPGA_Evaluation_Kit\NIOSY_Example\software\hal_bsp\settings.bsp — m] x
File Edit Tools Help
Main  Software Packages Drivers Linker Script  Enable File Generation  Target BSP Directory
SOPC Information file: ..\..\MIOSV.sopdnfo
CPUname: intel_niosv_m_0
Operating system:  Altera HAL Version: |default ~
BSP target directory: .\
hal
E-Common .
max_file_descriptors
) hal Hie_descrp 32
--sys_clk_timer . " .
timestamp_timer () enable_instruction_related_exceptions_api
stdin log_port none -
~stdout
~stderr 8 enable_exit
~-enable_reduced_device_drivers
--enable_sim_optimize 8 enable_clean_ext
E-linker () enable_runtime_stack_checking
enable_exception_stack
exception_stack_size @ enable_c_plus_plus
*-exception_stack_memory_region_nar) [] enable_lightweight_device_driver_api
=-mzke X
i--cflags_debug log_flags: 0
cflags_optimization "
- sys_clk_timer:
cflags_warnings S _clic] intel_niosv_m_0 -~
enable_cflag_fstack_protector_strong i .
H —- - — = imestamp_timer:
*-enable_cflag_wformat_security intel_niosv_m_0 ~
-Advanced stdin ftag_uart 0 -
stdout: jtag_uart 0 -
stderr: jtag_uart 0
() enable_reduced_device_drivers
] enable_sim_optimize
hallinker
@ allow_code_at reset
M cnahla alt Inad
Information  Problems Processing
e = = =
@ Mapped section ".stack™ to memory region "onchip_memory2_07.
@ Setting "hal.linker .exception_stack_memory_region_name” set to "onchip_memory2_0",
@ Td message: "Mo bootloader located at the reset address.” |
@ Tl message: “Application ELF allowed to contain code at the reset address,”
Generate Exit
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tor - EA\FPGANINtel Max_10_FPGA_Evaluation_Kit\NIO!

= B ampleisoftware! ettings.bsp = m] X
File Edit Tools Help
Main  software Packages Drivers Linker Script  Enable File Generation  Target BSP Directory
SOPC Information file: E:\FPGA\Intel_Max_10_FPGA_Evaluation_Kit\NIOSV_Example \MIOSV.sopcinfo
CPUname: intel_niosv_m_0
Operating system: Altera HAL Version: |default ~
BSP target directory: .. %44 ACHintelFPGA lite |24, 1stdniosvibin
hal
=-Common
max_file_descriptors:
= hal SR 32
--gys_clk_fimer
timestamp,_timer (] enable_instruction_related_exceptions_api
stdin () use_dfl_walker
stdout
df_start_address -
-stderr - - 1
nable_reduced_device_drivers log_port: = )
--gnable_sim_optimize
I-linker
H enable_exit
i--enable_exception_stack a -
exception_stack_size B enable_clean_exit
exception_stack_memory_region_r
-use_picolbc () enable_runtime_stack_checking
=-make [ enable_c_plus_plus
cflags_debug
cflags_optimization (] enable_lightweight_device_driver_api
cflags_warnings log_flags: 0
Information  problems Processing
@ Finished loading BSP section mappings from settings file.
@ Setting "hal.linker. exception_stack_memary_region_name” set to "onchip_memory2_0",
@ Loading drivers from ensemble report.
(@ Mapped module: “intel_niosv_m_0" to use the default driver version.
@ Mapped module: "sysid_gsys_0" to use the default driver version.
@ Mapped module: “jtag_uart_0" to use the default driver version,
@ Finished loading drivers from ensemble report.
@ Loading BSP settings from settings file,
(@ Finished loading SOPC Builder system info file "E: \FPGA\INtel_Max_10_FPGA_Evaluation_Kit\NIOSY_ExampleNIOSV. sopeinfo™
Generate Exit
12. Under Common, check enable_reduced_device_drivers
= BSP Editor - E\FPGA\Intel_Max_10_FPGA_Evaluation_Kit\N Example\softwa ettings.bsp = O X
File Edit Tools Help
Main  Software Packages Drivers Linker Script  Enable File Generation  Target BSP Directory
SOPC Information file:  E:\FPGA\Intel_Max_10_FPGA_Evaluation_Kit\NIOSY_Example\NIOSY. sopcinfo
CPU name:  intel_niosv_m_0
Operating system:  Altera HAL Version: | default ~
BSP target directory: ..\ S intelFPGA_lite24. 1stdYniosvibin
[=-Settings hal
[=RCommon
sys_clk_timer: i
E-hal SES intel_niosv_m_0 ~
sys_ck_timer timestamp_timer: intel_niosv_m_0
timestamp_timer
stdin stdin: jtag_uar_0
stdout
stderr stdout ftag_uar_0 ~
enable_reduced_device_drivers
enable_sim_optimize stderr: jtag_uar_0 ~
8 enable_reduced_device_drivers
[_] enable_sim_optimize
hallinker
[C) enable_exception_stack
cflags_optimization exception_stack_size: 1024
--cflags_warmnings
exception_stack_memory_region_name: onchip_memory2_0
Information Problems Processing
@ Finished loading BSP section mappings from settings file.
@ Setting "hal.linker.exception_stack_memory_region_name” set to "onchip_memory2_0"
@ Loading drivers from ensemble report.
(@ Mapped module: “intel_niosv_m_0" to use the default driver version.
@ Mapped module: “sysid_gsys_0" to use the default driver version,
@ Mapped module: “jtag_uart_0" to use the default driver version.
@ Finished loading drivers from ensemble report.
@ Loading BSP settings from settings file,
(@ Finished loading SOPC Builder system info file "E:\FPGAVIntel_Max_10_FPGA_Evaluation_Kit\WIOSV_Example \NIQSV.sopanfo”
Generate Exit
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13. Click the Generate button.

14. Once the BSP has been generated, click on Exit to close the BSP Editor.

15. Open File Explorer, and navigate to \NIOSV_Example\software folder. You will see what
BSP files were generated.

MName Date modified Type Size

drivers 11/15/2023 7:46 PM File folder

HAL 11/15/2023 7:46 PM File folder
] alt_sys_init.c 11/15/2023 7:46 PM C Source 4KB
|=| CMakelists.tet 11/15/2023 7:46 PM Text Document 6 KB
[ linkerh 11/15/2023 7:46 PM C/C++ Header 3KB
[ tinkerax X File 13KB
D memeary.gdb 11/15/2023 7:46 PM GDB File 3KB
D settings.bsp 11/15/ 7:46 PM BSP File 41KB
& summary.html 11/15/2023 7:46 PM Microsoft Edge H... 4T KB
[ system.h 11/15/2023 7:46 PM C/C++ Header 12KB
D toolchain.cmake 11/15/2023 7:46 PM CMAKE File 2KB

16. Under \NIOSV_Example\software folder, create a subfolder called “app.”
17. Create a text file called main.c in the \NIOSV_Example\software\app folder.

I

w NIOSY_Example MName Date modified Type
.gsys_edit [ main.c 8/17/2025 8:26 PM C Source
> db
> incremental_db

ip_upgrade_port_diff_reports
> NIOSV
output_files
hd software
app
~ bsp

> drivers

18. In the Nios V command shell, change directory to the \NIOSV_Example\software\app
19. ]Ic?({)lljietrr.me following command:
niosv-app -b=../bsp -a=. -s=main.c
20. A CmakelList.txt file gets generated, open the text file in an editor.
cmake_minimum_required(VERSION 3.14)
add_subdirectory(../bsp bsp)

include(../bsp/toolchain.cmake)
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project(app)

enable_language(ASM)
enable_language(C)
enable_language(CXX)

add_executable(app.elf)

target_sources(app.elf
PRIVATE
main.c

)

target_include_directories(app.elf
PRIVATE
PUBLIC

)

target_link_libraries(app.elf
PRIVATE
-T "${BspLinkerScript}" -nostdlib
"${ExtraArchiveLibraries}"
-WI,--start-group "${BspLibraryName}" -Ic -Istdc++ -Igcc -Im -WI,--end-group
)

# Create objdump from ELF.
set(objdump app.elf.objdump)
add_custom_command(
OUTPUT "${objdump}"
DEPENDS app.elf
COMMAND "${ToolchainObjdump}" "${ToolchainObjdumpFlags}" app.elf >
"${objdump}"
COMMENT "Creating ${objdump}."
VERBATIM

)
add_custom_target(create-objdump ALL DEPENDS "${objdump}")

# Report space free for stack + heap. Note that the file below is never created
# so the report is always output on build.
set(stack_report_file app.elf.stack_report)
add_custom_command(
OUTPUT "${stack_report_file}"
DEPENDS app.elf
COMMAND niosv-stack-report -p "${ToolchainPrefix}" app.elf
COMMENT "Reporting memory available for stack + heap in app.elf.”
VERBATIM

)
add_custom_target(niosv-stack-report ALL DEPENDS "${stack_report_file}")

# Generate HEX file(s) from app.elf using elf2hex tool.
# Note : If ECC Full is enabled, width of 39 is set for NiosV TCM. Otherwise, 32.
add_custom_command(
OUTPUT "onchip_memory2_0.hex"
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DEPENDS app.elf

COMMAND elf2hex app.elf -o onchip_memory2_0.hex -b 0x00010000 -w 32 -e
0x00017CFF -r 4

COMMENT "Creating onchip_memory2_0.hex."

VERBATIM

)
add_custom_target(create-hex ALL DEPENDS "onchip_memory2_0.hex")

1.3 Part 3: Write the helloapp Application in RiscFree IDE for Intel FPGAs
Now, we are ready to write the applications in the RiscFree IDE.

1. Open niosv-shell if not already open.
2. Type the following and hit enter to start RiscFree IDE:

riscfree.exe
Warning: The reason to open RiscFree.exe via niosv-shell is to take advantage of the niosv shell
path settings so the build tools can run the HEX generation convertions. If RiscFree.exe is run

outside the niosv-shell environment, the application will be built, but fail on the HEX conversion.

3. Keep the default work space and click Launch.
4. Click on Create Project or from the menu select File->"Import Nios V CMake project...”

Workspace2 - Ashling RiscFree™ IDE

File Edit Source Refactor Mavigate Search Project Run
New Alt+Shift+N > tior
Open File...

[y Open Projects from File System...

Recent Files »
& Refresh F5
Convert Line Delimiters To >
. Import.. Import Nies ¥ CMake based project
2 |mport Nios V CMake project...
iy Bxport..
Properties Alt+Enter
Switch Workspace >
Restart
Exit

5. In the import dialog, click on browser and open the app folder location. The project name
will automatically fill with the folder name.
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Import Existing Code
Import Mios V CMake based project.

Project name :

app

Mios V CMake project location :
EAFPGANIntel_Max_10_FPGA_Evaluation_Kit\NIOSV_Example\software\app

Browse...

Cancel

6. You can change the name if you wish. For this example, the project name will be helloapp

1)

Import Existing Code
Import Mios V CMake based project.

Project name:

helloapp

Nios V CMake project location :
EAFPGANIntel_Max_10_FPGA_Evaluation_Kit\NIOSV_Example\software\app

7. Click Finish.
8. Open the main.c and fill in the following code:

#include "sys/alt_stdio.h"
int main(){

alt_putstr("Hello from Nios V!\n");
alt_putstr("Programming for RISC V is fun!\n");

int x = 5;
inty =10;
intz=x*y;

/INever exit the program
while(1);
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return 0;

9. Near the bottom right, set the console output to CDT Build Console [app].

- rzﬁ * = 0

BE = B/ &
1 COT Glekal Build Censcle
2 CDT Build Console [app]
3 CMake Console [app]

4 Script Pad Console

momm O

10. Right-click on app project and select Build Project from the context menu. The build should
complete successfully with a app.elf file being created.

[#] Problems J=| Tasks [ Console x [C] Properties 4 Search
CDT Global Build Console
| 97%] Creating app.elft.objdump.
[ 98%] Reporting memory available for stack + heap in app.elf.
[1@e%] Creating onchip_memory2_ @.hex.
TBBmalloc: skip allocation functions replacement in ucrtbase.dll: unknown prologue for function _msize
[1ee¥] Built target create-objdump
app.elf
* 26.49 KB - Program size (code + initialized data).
* 38280 B - Free for stack + heap.
[1@e%] Built target create-hex
[1@e%] Built target niosv-stack-report

19:21:27 Build Finished. ® errors, 1 warnings. (took 14s.5ms)

Notice that the program size is 26.49 KB and free space for the stack and heap is only 3020 Bytes.
For Niosll, a similar program was only 732 bytes in size so there is a big increase in memory
required.

Warning: If you open RiscFree IDE independently of the niosv-shell, an error will appear at the end
of the build. The elf file was built, but the paths to run the stack report and create HEX files were
invalid. You can always run the niosv-stack-report.exe and elf2hex.exe seperatly.

f. Problems =] Tasks B Console x  [] Properties < Search %| &34
CDT Global Build Console

| 98%] Creating app.elt.objdump.

[1@@%] Reporting memory available for stack + heap in app.elf.

process_begin: CreateProcess(NULL, niosv-stack-report -p riscv32-unknown-elf- app.elf, ...) failed.

make (e=2): The system cannot find the file specified.

make[2]: *** [(MakeFiles/niosv-stack-report.dir/build.make:73: app.elf.stack report] Error 2

make[1]: *** [(MakeFiles/Makefile2:177: CMakeFiles/niosv-stack-report.dir/all] Error 2

make[1]: *** Waiting for unfinished jobs....

[1e8%] Built target create-cbjdump

make: *** [Makefile:91: all] Error 2

"C:/fintelFPGA_lite/24.1std/riscfree/build_tools/bin/make.exe -j all™ terminated with exit code 2. Build might be incomplete.

14:81:81 Build Failed. 4 errors, 1 warnings. (tock 13s.246ms)
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1.4 Part 4: Test the Design and the Application
With the design and application compiled, we can now test the design and application on the board.

1.4.1 Program the Board
We will go back to Quartus and program the board with the design.

1. Connect the board and the programming cable together per the cable instructions.

Note: The MAX 10 — 10M08 Evaluation Kit doesn’t come with a programming cable or built-in JTAG
USB Blaster II. You will have to use either the USB Blaster Il or EthernetBlaster Il external cables.
The EthernetBlaster 1| was used. DHCP setup was not working, so a direct Ethernet cable
connection was made between a PC and the EthernetBlaster Il. Set the static IP for the PC network
card to 198.162.0.1. Access the EthernetBlaster Il via a browser and then change the IP to a static
IP that matches the network. The new IP address was used as the Server name. Your experience
might be different.

2. Power on the board and the programming cable box.
3. In Quartus Prime, from the Task pane, right-click on Program Device (Open Programmer)

and select Open from the context menu or click on the i icon on the toolbar.

4. The Programmer dialog appears, click on the “Hardware Setup” button.

5. Click the Add hardware button, select the Hardware type, and fill in any remaining
information, and click OK.

.

Hardware Settings JTAG Settings

Select a programming hardware setup to use when programming devices. This programming
hardware setup applies only to the current programmer window.

Currently selected hardware: | No Hardware

W Add Hardware

Hardware type: EthernetBlaster =
Port:

Baud rate:

Server name: -
Server port: 1309

Server password:

Auto Detect OK Cancel

Close

6. The tool allows you to connect to a number of programming cables. We need to select the
one for our board. In the “Currently selected hardware”, click the drop-down, select the
hardware cable for the board, and click Close when finished
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B Hardware Setup

Hardware Settings JTAG Settings

Select a programming hardware setup to use when programming devices. This programming

hardware setup applies only to the current programmer window.

Currently selected hardware: | EthernetBlasterll on 192.168.1.198 [EthernetBlasterl(] hd

Hardware frequency: Hz

Available hardware items

Hardware Server Port Add Hardware. ..

EthernetBlasterll 192.168.1.... EthernetBL..

Close

7. An NIOSVCPUExample2.sof file gets created during the Compile Design flow. The file is
automatically filled in. There is only one FPGA on the board and in the JTAG chain so the
file already has the Program/Configure checkbox checked. Click the Start button to
program the board. The process takes a few seconds and shows that the task was

completed successfully.

Y Progr A u - NIOSVCPUExample - [NIOSVCP = (m]
earch Intel FPGA [5]
o Hardware Setup... | | on 192.168.1.198 [EthemetBlasterl]|  Mode: | JTAG = Progress: 100% (Successtul)
Enable real-time ISP o allow background programming when available
o File Device Checksum  Usercode  Program/  Verify Blank-  Examine  Security
St Configure Check Bit
flssop output_filss/NIOSVCP 10MOBSAET44  0042D404  0042D404 v
# auto Detect
Delete
™ add File...
] v
* Add Device... LT
LTI
hyyp, — b
% pown s :

T0MOBSAET144

Notice that there is no time constraint dialog box popping up. The Nios V is free and doesn’t
required a paid license.

Copyright © 2025 Annabooks, LLC. All rights reserved

Intel is a registered trademarks of Intel Corporation

Quartus, Nios I, Nios V, and MAX 10 are registered trademarks of Altera

All other copyrighted, registered, and trademarked material remains the property of the respective owners.

26



Rev 0
Annabgoks®

1.4.2 Debug the Application
Now, we go back to the RiscFree IDE to download and debug the applicaiton

1. With the JTAG cable connected, in RiscFree IDE, right click on the helloapp in Project
Explorer.

2. Select Debug AS->Debug Configurations...
3. Click on Ashling RISC-V hardware Debugging
4. In the Main tab, you should see the project pointing to the Project and the app.elf file.

Name: app.elf

[E] Main Ek{faDebugger = Startup ﬁOSAwareness % Source| [C] Commeon | 2, SVD Path
Project:

helloapp Browse..,

C/C++ Application:
build/Default/app.elf

Variables... Search Project... Browse..,

Build (if required) befere launching

Build Configuration: Default -

(_) Enable auto build (") Disable auto build

© Use workspace settings Configure Workspace Settings...

Click on Debugger tab.

Set the Debug probe to the debug probe connected to the board.

Set the JTAG frequency to 16 MHz

Click on the “Auto-detect Scan Chain”. The Devcie/TAP selection should be filed in with
the 10M08 FPGA and the Core selection should be the Nios V.

©®NoO

MName: helloapp Debug

2| Main % Debugger | = Startup | (5 05 Awareness 1 Source| ] Common | 2, SVD Path
Debug Probe Configuration

Debug probe  EthernetBlasterll on 192.168.1 ~ o Transport type JTAG
JTAG frequency 16 ~ MHz
Target Configuration

Auto-detect Scan Chain

Device/TAP selection 10MOB5A(.|ES)/TOMOB5(CIL) { Core selection Mios 'V (0x

[[] Do not halt the target [Jlssue TAP reset
8 Reset mstatus CSR register

GDB Server Setup

Additional command-line arguments

GDB Client Setup

Executable name: S{eclipse_homel/../toclchain/riscv32-unknown-elf/bin/riscv32-unknown-elf-gdb.exe Browse...  Variables...

Custom instruction file:  Seclipse_homel/../debugger/gdbserver-riscv/niesv_custom_instrxml Browse...  Variables...

Other options:

Commands:

9. Click Apply
Copyright © 2025 Annabooks, LLC. All rights reserved

Intel is a registered trademarks of Intel Corporation
Quartus, Nios I, Nios V, and MAX 10 are registered trademarks of Altera
All other copyrighted, registered, and trademarked material remains the property of the respective owners.

27



Rev 0
Annabgoks®

10. Click Debug. The application will download and stop at the first line in Main().

[g] maine X [§] ertDS ‘) alt_stdio.h = B (=Varia. X O Brea.. & Expr.. B Mod.. I, Peri.. Ui Regi. = 8

#include "sys/alt_stdic.n"

. Neme Type Value
int main(}){
0 x int 0
alt_putstr("Hello from Nios B &=y int 68268
alt_putstr("Programming for RISC V is fun!\n"); =z int 1000

int x = 5;
int y = 10:
int z = x * y;

while(1):

return 0;

11. Open NIOSV-Shell
12. Run the following command to start the terminal application: juart-terminal

niosv-shell - juart-terminal X + v

Entering Nios V shell
Microsoft Windows [Version 10.8.22631.U317]
(c) Microsoft Corporation. ALl rights reserved.

[niosv-shell] C:\intelFPGA_lite\23.1lstd\niosv\bin> juart-terminal

juart-terminal: connected to hardware target using JTAG UART on cable

juart-terminal: "EthernetBlasterII on 192.168.1.198 [EthernetBlasterII]", device 1, instance ©
juart-terminal: (Use the IDE stop button or Ctrl-C to terminate)

13. In RiscFree IDE, step throught the code. You will see the messages sent to the juart-
terminal.

niosv-shell - juart-terminal * + -

Entering Nios V shell
Microsoft Windows [Version 10.8.22631.4317]
(c) Microsoft Corporation. All rights reserved.

[niosv-shell] C:\intelFPGA_lite\23.1std\niosv\bin> juart-terminal

juart—terminal: connected to hardware target using JTAG UART on cable

juart-terminal: "EthernetBlasterII on 192.168.1.198 [EthernetBlasterII]", device 1, instance ©
juart-terminal: (Use the IDE stop button or Ctrl-C to terminate)

Hello from Nios V!
Programming for RISC V is fun!

14. Like any debugger, as you continue to step through the code you can see the variables
changes, as well as other processor registers and memory.

[ mainc X [§] ert0S T alt_stdio.h = B ®-Varia.. X 9gBrea.. &7 Expr.. @4 Mod.. 7 Peri. ¥if Regi = E
#include "sys/alt_stdio.n" = ‘ 5 et
B S int matn() ( Name Type Value
. e x int 5
alt_putstr(" ey int 10
alt_putstr(" ez int 50

int x = 5;
int y = 10;
int z = x * y;
ever exit the program

while(1):

return 0;

15. Stop debugging when fnished.
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1.5 Nios V Applications are Bigger, a New Platform Moving Forward

As called out in the application build results, the Nios V applications are bigger, which is too big for
the MAX10 10M08 FPGA. If there was external RAM memory available, then the program would
fit easily. Intel® MAX® 10-10MO08 Evaluation Kit has been a fun cheap board to work with, but the
platform is not the best to continue with Nios V examples. Future articles and other publications will
be using the MAX10 10M50 board with RAM and ROM.

1.6 Summary: A Change in the Process

The article covered the basic steps to create a FPGA design for the Nios V and then create and
debug an application using the Ashling RiscFree™ IDE. Since Nios V is free there is no limitation
like teathering or timeout like there is with the Nios Il. The development process to write Nios V
applications is very different than the Nios Il, but in a couple artciles, we will see how VS Code
simplifies the process.

1.7 References
The following references were used for this article:

RiscFree IDE Documentation:
https://www.intel.com/content/www/us/en/docs/programmable/730783/24-2/about-the-ide.html

Video: Debugging the Nios® V Processor Using the RiscFree* IDE for Intel® FPGAs
Video: Build A Soft Core CPU - Part Three - NIOS Il in Intel FPGA
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